
00309

No. of Printed Pages : 24 CIC - 5 (E+H)

CERTIFICATE IN COMPUTING (CIC)
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June, 2010

CIC-5 : MICROSOFT OFFICE

Time : 2 hours	 Maximum Marks : 100

Note :

Do not start answering until the invigilator asks you to start.

Question paper contains 100 questions. All questions are to be answered.

All questions carry equal marks.

For each question only one answer should he given. If more than one answer is marked, zero

marks will be awarded.

A. Multiple Choice Questions (Question Number 1 to 50) :

Note :
	 Four choices are given for each question, out of which one choice may he correct. Mark relevant •

choice in the answer sheet provided to you. In case you fed that none of the answers given is

correct, mark '0'.

In Microsoft PowerPoint two kinds of sound effects files that can be added to the
presentation are 	

(1)	 .wav files and .mis files	 (2)	 .wav files and .gif files

(3)	 .wav files and .Jpg files	 (4)	 .Jpg files and .gif files

Which PowerPoint view works best for adding slide transitions ?

(1)	 Slide show view
	 (2)	 Slide shorter view

(3)	 Slide view
	 (4)	 Notes view

3.	 Which of the following is not a way to create a new presentation ?

Using the Scan-In slides features

Create a blank presentation

Using a template

Using the auto content wizard
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4.	 The quickest way to create a PowerPoint Presentation is to use the

Word for windows templates

Auto creation wizard

Auto content wizard

Presentation wizard

	

5.	 Which of the following is the default page setup orientation for slides in PowerPoint ?

(1) Vertical
	

(2) Landscape

(3) Portrait
	

(4) None of the above

	

6.	 The toolbars that are displayed by default in the PowerPoint window includes

Menu bar, Standard toolbar, Formatting toolbar, Drawing toolbar, Status toolbar.

Standard toolbar, formatting toolbar, Drawing toolbar

Menu bar, Drawing bar, Standard toolbar, Status toolbar

Menu bar, Drawing toolbar, Standard toolbar, Formatting toolbar

Which command brings you to the first slide in your presentation ?

(1) Next slide button
	 (2) Page up

(3) Ctrl + Home
	

(4) Ctrl + up

You were giving your presentation, and you need to click a slide that's few slides back.
How do you get there ?

Press ESC to get back into a normal view

Press Backspace until your desired slide

Right click, point to go on the shortcut menu, Point to by title, and click the slide
you want to go

All of the above

The PowerPoint view that displays only text (title and bullets) is 	

(1) Slide show	 (2) Slide sorter view

(3) Note page view	 (4) outline view

On which part of the chart, the values entered in a data sheet display ?

(1) The title area	 (2) The legend

(3) The y-axis	 (4) The x-axis
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11. Which of the following uses of the spelling and grammer feature to indicate an incorrect
spelling ?

The incorrect word appears in all capital letters
The incorrect word has a wavy red line under it
The incorrect word appears red
The incorrect word appears blue

12. Auto clip art is a feature that 	
Automatically places clip art in your presentation
Scans your presentation for incorrect spelling
Scans your presentation for incorrect spellings in incorrect word art objects
All of the above

13. Which of the following is not a feature of PowerPoint ?
Printing Transparencies
Drawing with a pen
Printing the speaker's notes along with slides image
Linking a slide transition with a laser printer

14. The boxes that are displayed to indicate that the text, pictures or objects are placed in
it are called 	
(1)	 Place holder	 (2)	 Auto text
(3)	 Text box	 (4)	 Word art

A chart can be put as a part of the presentation using 	
(1)	 Insert —> chart 	 (2)	 Insert —> chart --> new
(3)	 Insert —> pictures —> chart 	 (4)	 View —> chart

Which key on the keyboard can be used to view slide show ?
(1)	 Fl	 (2)	 F2
(3)	 F5	 (4)	 F8

A file which contains ready-made styles that can be used for presentations is called

(1) Auto style
(3) Wizard

(2) Template
(4) Pre-formatting

Which of the following feature allows you to select more than one slide in slide sorter
view ?
(1) Alt + click each slide	 (2) Shift + drag each slide
(3) Shift + click each slide	 (4) Ctrl + click each slide
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Which of the following tools enable you to add text to a slide without using the standard
place holders ?
(1) Text box tool	 (2) Line tool
(3) Fill color	 (4) Auto shapes tool

Which view in PowerPoint can be used to enter speaker comments ?
(1) Normal	 (2) Slide show
(3) Slide sorter	 (4) Notes page view

21. To make a number in cell Cl 10% smaller than the number in C3 you enter
(1) = C3*1.10 (2) + C3*1.10
(3) = C3*90 (4) = C3*.90

The cell reference from a range of cells that starts in cell B1 and goes over to column G
and down to row 10 is 	
(1)	 B1 —G10	 (2)	 B1 = G10
(3)	 B1 ; G10	 (4)	 B1 : G10

There are three types of data found in spread sheet :
(1)	 data, words, numbers 	 (2)	 Equations, data, numbers
(3)	 words, numbers, labels	 (4)	 numbers, formulas, labels

24. Auto calculate will quickly add selected cells if you 	
right click on the status bar and select sum
click the Auto calculate button on the toolbar
use the key combination ctrl+$
double click the selection

25. When you are typing an equation into a cell the first thing that must be entered is
•

(1)	 the first cell referenced	 (2)	 parenthesis
(3)	 quotation marks	 (4)	 an equal sign

26. What does SUMIF function do ?
Adds up cell values based on a condition
Adds all the numbers in a range of cells
Returns a subtotal in a list or database
All of the above

27. To open the Format Cell dialog box, press :
(1)	 Alt + 1	 (2)	 Ctrl + 1
(3)	 El	 (4)	 Shift + 1
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To move to the previous worksheet, press :
(1)
	

Alt + Pg Up
	 (2)	 Ctrl + Pg Up

(3)
	

Ctrl + Pg Dn
	 (4)	 Shift + Tab

3-D references in a formula :
Can not be modified
Limits the formatting
Only appears on summary worksheets
Spans worksheets

30. The chart wizard 	
can place a chart on a new chart sheet or any sheet in the workbook
can place a chart on new chart sheet
can only place a chart on a new blank worksheet
can only be used to create embedded charts

31. Which option do you press to enter the current date in a cell ?
(1)
	

Ctrl + Shift + :
	 (2)	 Ctrl + ;

(3)
	

Ctrl + F10
	

(4)	 All of the above

To protect a worksheet, you can choose protection and the protect sheet from the
•

(1)	 Edit	 (2)	 Format
(3)	 Tools	 (4)	 Data

You can quickly change the appearance of your work by choosing Auto Format from
the 	 menu.
(1)	 Edit	 (2)	 View
(3)	 Format	 (4)	 Tools

To open an existing workbook, you can click the open button on the 	 toolbar.
(1)	 Drawing	 (2)	 Formatting
(3)	 Forms	 (4)	 Standard

What is the keyboard shortcut for creating a'chart from the selected cells ?
(1)	 F3
	

(2)	 F5
(3)	 F8
	

(4)	 F11
•

36. A program which helps to create written document and lets you go back and make
corrections as necessary ?
(1)	 Database	 (2)	 Spreadsheets
(3)	 Word processor	 (4)	 All of the above
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Which of the following shortcut key is used to check spelling ?

(1)	 Fl	 (2)	 F2
(3)	 F7	 (4)	 F5

Which word processing utility could you use to find the synonym of a word ?

(1)	 Spell checker	 (2)	 Thesaurus

(3)	 Out-liner	 (4)	 Grammar checker

39. Menu item in dim color (gray) indicate that the menu is :

Unavailable for current context

Not much required menu
Toggle menu

Over used menu

40. To prevent other users from opening a document which of the following should be
clicked in the options command in Tools menu :

Protection password box

Write reservation password box

Read only recommended box

Either (2) or (3)

41. While using the data from other applications in the data source file 	
the records must contain multiple fields

the merge fields in the documents must match those in the data source
you must first click the Creates Data Source button

none of the above

42. The default units for the document margins can be changed by choosing which of the
following tabs in the option box ?

(1)
	

View tab
	

(2)	 Edit tab

(3)
	

General tab
	

(4)	 Print tab

43. To remove a tab from the ruler :

Double click the tab on the ruler

Select the tab and press the Delete key

Drag the tab from the ruler

None of the above
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During the spell check ; word uses the English (US) dictionary as its main dictionary,
supported by :

(1) US.DIC	 (2) SCIENCE.DIC

(3) CUSTOM.DIC	 (4) FRENCH.DIC

The keyboard shortcut keys for undoing the modifications made to a document are :

(1) Alt + Z	 (2) Shift + Z

(3) Tab + Z	 (4) Ctrl + Z

The processing power of CPU is measured in 	

(1) CIPS
	

(2) MIPS

(3) BITS
	

(4) Milliseconds

What is the original or highest directory on a disk ?

(1) Tree
	 (2) Root

(3) C : >
	

(4) D : >

48. The information processing cycle includes :

Input, processing, output, storage

Input, output, manipulation, print

Data, processing, printing

Storage, display, data

49. Individual dot on a computer screen is called :

(1) Character

(3) Font

50. ALU stands for :

Arithmetic Logic Unit

Arithmetically Logic Unit

Arithmetic Logical Unit

Arithmetic Logically Unit

(2)	 Screen point

(4)	 Pixel
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B.	 States whether the following statements are True (1) or False (0) [51-100] :

Date and Time entries are interprets in a special way in Excel.

Menu bar shows the name of application, document group, or a directory.

To close an active application window or quit an application, press CTRL + F4.

To select a menu, press ALT + underlined character in the menu name.

A dialog box supplies additional information to a command required for completion of
a task.

Command buttons represent a group of mutually Exclusive options.

Auto-correct Automatically corrects many common typing, spelling and grammatical
errors.

The AutoFormat feature in word works behind the scenes to produce an attractive,
easy to read document while you concentrate on the content.

In word, you can import a Microsoft Excel worksheet arrange by opening the workbook
it's stored in.

To move to the beginning of the document, press CTRL + End.

The major portion of the Paintbrush window is taken by the drawing area where you
create or change a drawing.

In Paintbrush, the Eraser tool changes foreground colors to the selected background
color.

The "Thesaurus" can be used to improve the precision and variety of your writing.

Characters don't include letters, numerals, symbols, punctuation marks and spaces.

In MS-Word, paragraph command on the View menu can be used to add space before
and/or the paragraph.

Left option of horizontal alignment aligns the contents to the right of the cell.

67.	 Absolute reference refers to the cell relative to the given position.
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Hard Page Breaks are automatically inserted by word, when text reaches the bottom
margins and are represented by a dotted line across the document.

Modifying a table involves selecting, inserting, deleting, copying and moving rows,
column and cells.

70. Autofill helps you to fill rows or column with series of data.

.71. To remove a worksheet from the workbook, select Delete Sheet from the Edit Menu.

Number formats are used to format various kind of numerical data.

One control can be linked to only one cell but one cell can have many controls linked to
it.

Bar chart shows the magnitude of change over time.

The records once entered in the database list can't be changed or modified.

One way of putting across ideas effectively, is the use of visual images.

MS-Excel document is called as a workbook and each workbook contains 12 worksheets
by default.

You can restrict the access of a particular workbook from other users in only one way.

You can press Ctrl + F6 to go the previous window.

Formulas can be used with functions to form complex equations.

Various operations can be carried out with the data like sorting, searching and totaling.

From the PowerPoint window, you create Presentation and use its toolbars and menus.

Separate chart sheets are inserted when a chart is created.

Databases created in the worksheet are called internal database in MS-Excel.

In MS-Word, you can add a special effect to text by the Word Art button on the Drawing
toolbar.
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MS-Word uses "soft" and "hard" page breaks to indicate when one page ends and
another begins.

To draw a straight line in Paintbrush, click Curve Tool from the toolbox.

With date and time functions in MS-Excel, you can analyze and work with date and
time values in formulas.

The function that is used in Excel to display the system date and time is WOW ( ).

The windows media player is a center for playing and organizing multimedia on your
computer and on the internet.

Bitmapped graphics are typical of Paint Programs which treat images as collections of
dots rather than as shapes.

OLE stands for Object Linking and Embedding.

Morphing is a form of animation.

The Web, and all the Internet formats, uses the protocol called TCP/IP.

The address of a web page it called a URL.

Hypertext is a collection of documents that contain cross-references called hyperlinks,
which allow the user to Jump easily from document to another.

In web page authoring, you can insert Active X controls onto a web page to design
forms to collect or provide dynamic data.

The word resolution is commonly uses to denote the total number of Pixels displayes
horizontally or vertically on the video display.

In Paintbrush, to print a picture, click save on the file menu,

100. You can't insert a video file into a word document by using Media Player.
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42.	 Document 14(1-4ff	 default zeE	 Option Box	 T1W-4 t I

(1)	 View tab	 (2)	 Edit tab	 (3)	 General tab	 (4)	 Print tab

tc-it	 	  :

(1)	 trrt	 f-FT 	
	

(2)	 ' 01-a4 alYT f-d-t4Vt

(3)	 .6(-1 . tr	 77qT4 I
	

(4)

-q-4-91 4,4 t )o-f,	 31-74 1371 y i z I q t.	 31t71. (US) 1.q .1-> 1 	 r chor t 71 -14-11-2.fd

t
(1)	 US.DIC gRI	 (2)	 SCIENCE.DIC giki

(3)	 CUSTOM.DIC	 (4)	 FRENCH.DIC 5.R1

Tyr	T1 f-*7 -r7	 iessl 'Add 7rr-rc -a 	 t :
(1)	 Alt + Z	 (2)	 Shift + Z	 (3)	 Tab + Z	 (4)	 Ctrl + Z

CPU	 744P-49 Vff-	 	 -Tint \-11d1 t I

(1)	 CIPS	 (2)	 MIPS	 (3)	 BITS	 (4)	 iiirriebs

ft-TzF ITT art zTT d-,ri	 7711t-?

(1)	 rit,	 (2)
	

(3)	 C : >	 (4)	 D : >

TE-49-r TI*77 .49- T41, 14 	 t :
(1)	 fir, 	 	 f4 4-1,	 (2)	 f9-- T, f9-44,	 f5177

(3)	 3if-*71, 7T1P-Ti,	 (4)	 rif-f(77,
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oirf-4-- a) J-Lze .k	 'TT ch rilar t -

(1)	 4S1(1	 	 (2)	 .-71;1-1f#s

ALU 3T0 t:
(1)	 Arithmetic Logic Unit
(3)	 Arithmetic Logical Unit

(3)	 Lhi u d 	(4)	 14atirf

(2) Arithmetically Logic Unit
(4) Arithmetic Logically Unit

B. 4ff1-17 7:1# t TIT + Irk! (Wrff*TgETT 51 * 100 .7W )

Ilz : 41 T150 TIVt 14, (1) alf-*-	 mZ i	 t	 7k---4 (0) a	 	  t-

TITE1 SI fa	 fa-4747- -774--u fad	 fit Aior 1

A alt 3T-9-4111, 31-4U, TIly z11	 Ic111-1.17:1f-d77191 tl

Tif*-7:1 al-TAITT fdut	 eht	 3T-1.77)1T 7774	 riC 7-4.7 CTRL+F4 I

*11 t c•i*-1-II+E ll ALT +	 on	 t-isia1rn -a-7 I

737fg a*-r	 chl	 F 3-1-4k7 *His	 3-ful-TT 77m far	 1

c6 4-11.5	 tco-f	 fad	 -r	 1-Itc\ t .mar t- I

Auto-correct -WO* 	 4 Z10f7T, a	 3 ce-ii ent	 1#4th' IdEfi TEM: VITM t I

a

	

	 AutoFormat	 ol q	 1T-4-4 3TRT1i -507g 3c-4W '11(4	 7-(W	 -cht cni

t

ast ', 3T7( cht ra g, 4;1	 	  31-Frra wT	 t I

7-44N t	 ricti	 CTRL + End	 I

a uz ,ef -Nut	 1117 3171 l	 r 4q. ltr ri if sitar ,30 371	 TI-A7 -71.1-10

iktra-vr	 c>q 1 4-11 ,31-i 1.,(4 3T1PTR i1T	 fat-Er -ggl fq iAr aerial t
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YI ,ohlf 13[41-TT 31.71-*-4 R-R11 c1d 	 mar 3-111f-*-Tr4 11NR4	 	 t 	

4H(11=1;1 14 31W, 3-* sici oh, Fa 1 4-ir-r-f 	 RT-b T-QTri 71Tf1:17 	  t

MS-Word 14 7771 	 111aiI	 AI4 *HIS 3fR/7 t)17)-rtF	 i (rb TP-Trff	 ,s4* 	
tl

Tr177.1711 4141 fci chc-Lt ehlr114)1 cbf gift	 3-1.-T-47qat114-UTIT *Of t1

f9-Ou fir obf 4.N f9-zrff	 or;Iiiichr*R1 t- I

'H46-114	 5R1 1:Erff: f8-N-E	 ,14 41c3-z-IRE c-Ic4 Trr-7r4	 trs'--4dr t 311Tr'o-u
347-7R (across) f4----zr tirch gl(f f;-R4i-R-r	 Inf tl

1:171:t 14-714 14 1:ff- t, 0610 44 AT	 -'ri-g-*-13-if q	 f	 f	 ry, Fc1014-1, Sifn1Mf4 chtu r 3	 4.-=10-f

atdfitff * I

aTtarl: Z agt*7it 	 	 tij 411 1hic1 4-1 91-it 14 3-1Tcf	 	 I 	 f t I

*1	 t-c-I chf 	 *I ,-171 06	 14114 Delete Sheet 141

*-1(w1 TFP	 c4r7m 51 ch1(	 31'071 3-11-*7.1 7114Z	 fr,'R .517 T fetr zficif t I

c4-)	 -0113TT	 1,11 f-Z	 ti cbc-11t 1T	 	  obIrPlobf t 3714	 -1471,-111=11,
t I

tf45-*-1 41	 chIciicR if Yrtc1c1 .-1 ot;1 1:ITT Term t 1

afw7 	 TO- 14 	 q1( 31f17 f{-"*Tt	 ,k ol -I 7 1#14.li-1	 	  t Trwt t 1

f-d- Tt e t1 714Tt.	kullrqd	 Tr 774 SI Fdrol ci1	 3r 11T

CIC-5 (E+H)
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77. MS-Excel	 71	 l * 14p-cichr	 Atir t 3 Z	 c	 1ni4P-dlir -4 0411,4 gill 12

01114 ,-N ob	 t I

78.3-77 'Telt 	 3.Ti -t4 -UrTzt <4)AP-di-if -T7 3T51-m Trlf-zm	 Tr-*--1

31111 fzl c	 ffilit T ‘s114	 Ctrl + F6 C GIf Try t I

vlfdri k-1 4-l ehk ulT4	 r	 l TFP:0 Trwrzil 	 Triq 	Tr-*---t

fdri-	 (sorting), 47 atiT q)+I s;)4 3-Ti-*7 f-*-7 TT73---*--t t• I

1Td7	 f-liTti -4 3-17 .5177jfff 779	 7,1—*t t 3 3-Trk	 311-.{ -4T -51-4FT	 7:1—*-1

-72r*	 	  t	 41	 747 f-*77 ,51111t I

ch144A oh1	 -T4ff f-*7 -17 311-	MS-Excel -4 311dir	 311 31 ti Tl zl ohs rilcir t

MS-Word 14 1 4 f 17,0 ,sitt 1 R c4	 3-TT qd-f 51tf 3-1111 41(5?-41W T fdt131 -PITq ,71

MS-Word . 7"fi .E	 Fri	 ' t14d	 11tf	 fd	 -741-7 cnot t ,714 cf-)

ilcir 3/1-T 7TT 	  	 t

-A-71 T T11	 ZL4rJ8-4	 Vt4o1+1 -4 Curve Tool -r-q rT c4	 I

MS-Excel 14 7TtN 3f1T T1171 31(7 Th-TreATTTITIATTITRI

Trw- ti

Tif-Tzrr f7-t4	 --rt-1-u AT 7177:1 1rei c4	 frigTRIT fwzrr 	 t, wow ( ) 	 t

fqnt -1:11ftm -TATR 3-Trtrk ob+-u-td( 1:17	 3-#T	 4)-0'1
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fq-E siFir-e4Nd	 U-N-mf	 <br *At 441-kilt

3-7-*-7

OLE	 3-10	 - Object Linking and Embedding

Triftrr q--iH q h-r =fir	 -) to-f t I

3-fR 74*	 ztaz m-r14-E FCP/IP	 ch,Cc'f t I

*-47-17 -T1 -Icif URL cWildr t1

1 ,-1(e. ott-d IT4d	 7:frAt t f7774 TTER	 s+rd fr r ell	 1-,fri 74 6414'1---r -)

7:1 .14' 3-3MT* A* z-1 4-1-f cht	 t I

4q	 14, 37P1	 7 14 NCI x fl o-il uf ffffIE cht Tr-*t	 J 1k1 ,4 rzTT 37F

4-)1 44	 7-*t t I

qg 4-111 0b TENR131-dqT qlftz4 1;K0 1:R Of-d- 	 TIT	 `4a -10.1 ch,k4

TFIT f.-*-74T 	 t-1

"kgaTT	 Fri .,r fArrE ct)	 .34f÷71 1 1, 71.{ Save fly =4-; I

317 itr-Tzrr 74-7 .5F1-1-rr	 s-v47(	 a-l-tzt	 f9-f-q-E-11.wT	 t
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-{TF chi4 t rc,t •1111
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TuF ----Fi	 fri	  Ai 1
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